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1.0 APPLICATION PAGES

1.1 REQUEST AN SSA-1099/1042S FOR TAX INFORMATION

Social SocurityOnline Replaee an SSA-1099/1042S (raxear2006)

www.socialsecurity.gov

Request an SSA-1099/1042S for Tax Information

You can request a copy of your most recent SSA-1099 or S5A-1042S using the buttons at the
bottom of this page

What is an SSA-1099/10428 e AR SSA-1099 s mailed to you in January showing the total amount of benefits you received in
Social Security Benefit the previous year. If you are a nonresident alien who received or repaid Social Security
Statement? benefits last year, you will receive an SSA-1042S instead

What You Should Know If you need a replacement SSA-1099 or SSA-10425 for an earlier tax year, contact us

You can request an SSA-1099/10425 for yourself or on behalf of a deceased beneficiary if
you are receiving benefits on the same record as the deceased

For security reasons, there is a 30 minute time limit to complete each page. We will wiarn you
wihen you run out of time. You can get more time to finish

What to Expect A copy of your SSA-1099/1042S willl arrive in the mail in about 10 days (30 days if you live
outside the United States). If you need it sooner, contact your Jocal Social Security Office

« The SSA-1099/1042S will be mailed to the address on file at Social Security.

If You Have Moved

If you have maved, you must report your change of address to us before we can process your
request

If you recently reported a change of address to SSA, you need to contact us to make your
request

For More Information For more information on taxation of Social Security Benefits, or to order the publication "Tax
information for Clder Americans” (Publication #554), call the IRS at 800-828-36786 or visit the RS
Web site

Special Instructions for People Who are Blind

Block Access to Your If you want to prevent online and automated tslephone access to your personal information, you can
Personal Information block access to your personal information

What Do You Want to Do?

Requestfor Myself

[ Request for a Deceased Person ]

Privacy Policy | Accessiplity Policy | Internet Security Policy | Site Map | Feedhack

Prepared by OSES/DBSD Page 1
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1.2 THISSERVICE ISCURRENTLY UNAVAILABLE

Social Security Online Replace an SSfX_lOgg/ 10428

Www.socialsecurity.gov

his Service Is Currently Unavailable

Tha; SSA-1099/1042S for Tax Year 2008 will be mailed by January 31, 2007
You can request a replacement SSA-1099/1042S for Tax Year 2006 on or after February 1, 2007
If you need a replacement S5A-1099/10425 faor Tax Year 2005 or earlier

« Callus toll-free at 1800-772-1213, or our toll-free TTY number, 1-800-325-0778: or

» VYisityour local Social Security Office
« [fyou live outside the United States, see Senvice Around the World.

Privacy Policy | Accessibiity Policy | Internet Security Policy | Site Map | Feedback

Prepared by OSES/DBSD Page 2



Title: iRRet Screensfor OMB Clearance Package

1.3 LEGAL ACKNOWLEDGEMENT

Social SocurityOnline Replace an SSA-1009/1042S (Tax Year2006)

Www.socialsecurity.gov

Legal Acknowledgement

s’m‘u o

il

Sacial Security provides this website for your convenience

Any person who knowingly and willingly makes any representation

1. thatis falze to obtain information from Social Security records, andfor

2. thatis intended to deceive the Social Security Administration as to the true identity of the
individual,

could be punished by a fine orimprisonment, or both

| have read the above statement and am the individual to whom the SSA-1099/10425 information

applies.

Prepared by OSES/DBSD Page 3
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|[See Revised Public Agreement Page |

1.4 PUBLIC AGREEMENT

Social SocurityOnline Replace an SSA-1009/1042S (Tax Year2006)

Www.socialsecurity.gov

ﬁw Public Agreement
R

Sacial Security provides this website for your convenience
The Privacy Act Statement

Paperwork Reduction Act

By using this website, you agree to its limitations

See Revised Privacy Act Statement

.|See Revised Paperwork
Reduction Act

Prepared by OSES/DBSD Page 4
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See Revised General Information About
You Page

1.5 GENERAL INFORMATION ABOUT YOU

Social SocurityOnline Replace an SSA-1009/1042S (Tax Year2006)

www.socialsecurity.gov

i General Information About You

Why do you need a _
replacement SSA-1099/104257

Have you had a change of o
address that has not been Yes
reported to Social Security? One

Previous Continue

Prepared by OSES/DBSD Page 5
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1.6 GENERAL INFORMATION ABOUT THE DECEASED

Social SocurityOnline Replace an SSA-1009/1042S (Tax Year2006)

www.socialsecurity.gov

== General Information About the Deceased

Why do you need a _

replacement SSA-1099/104257

Previous Continue

Prepared by OSES/DBSD Page 6
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See Revised Please Log In Page

17 PLEASELOGIN

Replace an SSA-1009/1042S (Tax Year2006)

www.socialsecurity.gov

ﬁw Please Log In
i

Please provide the following information to identify yourself. Be sure to type your name as it is
showin on your Social Security Card.

*Denotes required field

*Your Social Security Number: {without dashes or spaces)
Use your awn number even if you
are receiving benefits as a spouse,
parent or child under another
person's number

*Your Name:

First, Middle Initial (if any), Last,
Suffix (if anyd

Other Last Name (if any):

For example, your name as shown
on arecent letter from Social
Security or your maiden name

*Your Date of Birth: \ M [« [+

Month, Day, Year

Previous Continue

Prepared by OSES/DBSD Page 7
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18 PLEASELOGIN

Social SocurityOnline Replace an SSA-1009/1042S (Tax Year2006)

Www.socialsecurity.gov

Please Log In

it
Please provide the following information to identify yourself. Be sure to type your name as it is
showin on your Social Security Card.
If you are requesting an SSA-1099/10425 for a deceased beneficiary, you must be receiving
benefits as a spouse, parent or child on the same record as the deceased

*Denotes required field

*Deceased Beneficiary's Social {without dashes or spaces)
Security Number:

Verify who you are

*Your Social Security Number: {without dashes or spaces)
Use your awn number even if you
are receiving benefits as a spouss,
parent or child under another
person's number

*Your Name:
First, Middle Initial {if any), Last,
Suffix (if any)

Other Last Name (if any):

For example, your name as shown
on arecent letter from Social
Security or your maiden name

*Your Date of Birth: \
Month, Day, Year

Frevious Continue

Prepared by OSES/DBSD Page 8
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19 CONFIRMATION

Social SocurityOnline Replace an SSA-1009/1042S (Tax Year2006)

Www.socialsecurity.gov

Confirmation

oy ML
s

Thank you, Roger Field.
What You Should Know We received your request for a copy of an SSA-1099/10425 on Novermber 1, 2007

« You should receive your replacement SSA-1098/10425 by Mowvember 11, 2007 (December
1, 2007 if you live outside the United States)

o Itwill be mailed to the address Social Security has on file for you

o Ifyou do not recsive it by November 11, 2007 (December 1, 2007 if you live outside the
United States), please call us Monday-Friday 7:00 am.-7:00 pm. at 1-800-772-1213 or, if
you are deaf or hard of hearing, on our TTY number at 1-800-3256-0778

« Ifyoulive outside the United States, see Service Around the World

Use your browser’s "print" function to print this page for your records.

Does someone else in your
household want to request a Yes
replacement SSA-1099/104257 One

Privacy Policy | Accessibiity Policy | Internet Security Policy | Site Map | Feedback

Prepared by OSES/DBSD Page 9
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1.10 CONFIRMATION

Replace an SSA-1009/1042S (Tax Year2006)

Social Security Online

Www.socialsecurity.gov

Confirmation

Thank you, Roger Field.

What You Should Know We received your request for a copy of an SSA-1099/10425 for a deceased beneficiany with the
Social Security Mumber 001-01-0001 on Movember 1, 2007

» You should receive the replacement SSA-1099/10425 by November 11, 2007 {December 1,
2007 if you live outside the United States).

+ [twill be mailed to the address Social Security has on file for you

« [fyou do not receive it by Movember 11, 2007 (December 1, 2007 if you live outsids the
United States), please call us Monday-Friday 7:00 a.m.-7:00 p.m. at 1-800-7721213 or, if
wou are deaf or hard of hearing, on our TTY number at 1-800-325-0778

+ [fyou live outside the United States, see Service Around the World.

Use your browser’s "print" function to print this page for your records.

Does someone else in your o
household want to request a Yes
replacement SSA-1099/104257 One

Privacy Policy | Accessibiity Policy | Internet Security Policy | Site Map | Feedback

Prepared by OSES/DBSD Page 10
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2.0 MESSAGE PAGES

21 MSG024

SocialSeeuriy Online Replaee an SSA-1099/1042S (Taxvear2006)

www.socialsecurity.gov

s Special Instructions for People Who Are Blind

The following instructions are for screen reader users like JAWS and Window-Eyes and Browser
based readers like Home Page Reader

In order to fill out this application you will be required to tab to each control and provide the
requested information. Instructional text usually occurs at the beginning of each screen and can also
be accessed by tabbing through the screen. Tab indices have also been added to allow for tabbing
through text. Additionally, consistent headers have been set up to access questions and
examplesfinstructions more easily. All headers that are at level 3 will have additional help text
Additionally, the titles of each page are header level 1, and they will have general help information

Unless you have turned Javascript off in your browser, you will receive a warning after 25 minutes
and you can extend your time on the pages. After the third warning, you must move to another page,
or your time will run out and your work on that page will be lost

Atthe end of maost screens there is a Continue button to allow the user to go to the next page and a
Previous button to return to the prior page. The hotkey ALT + C is associated with the Continue
button, ALT + P for the Previous button, and ALT + 3 for the Exit button. Press Alt+ C or ALT + P
and then press Enter to maove forward or back, or ALT + X to exit

Close this windowi to return to the application

Prepared by OSES/DBSD Page 11
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2.2 MSG025

Replace an SSA-1009/1042S (Tax Year2006)

www.socialsecurity.gov

s Your Session Has Expired

If you would like to make this request online, you may select the Start Over button below. Select Exit
10 go to the Social Security home page

Prepared by OSES/DBSD Page 12
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2.3 MSGO027

Replace an SSA-1009/1042S (Tax Year2006)

Social Security Online
Www.socialsecurity.gov

Unable To Complete Your Request at this Time

oy ML
s

We are sorry for the inconvenience, but wie cannot process your request at this time
If you still wish to make your request, you may.

+ Tryagain later, or
» Callorwvisitus
o Inthe United States:
= call us at 1-800-772-1213 Monday through Friday between 7 am. and 7 p.m

= call our toll-free TTY number, 1-800-325-0778, if you are deaf or hard of hearing,
Wonday through Friday between 7 am.and 7 pm., or
= yisityour local Social Security Office.

o Ifyou live outside the United States, see Service Around the World

Prepared by OSES/DBSD Page 13
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24 MSG028

Replace an SSA-1009/1042S (Tax Year2006)

www.socialsecurity.gov

s This Service Is Not Available at this Time

This service is available during the following hours {Eastern time)

tonday through Friday: 5:00 Ak - 1:00 A
Saturday 500 AM-11:00 PM

Sunday: 8:00 AM - 10:00 P

Holidays: 5:00 Ab - 11:00 PM

Prepared by OSES/DBSD Page 14
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25 MSG030

T Replace an SSA-1009/1042S (Tax Year2006)

.gov

- We Are Processing Your Request...

Please wait a moment before selecting the Continue button

Prepared by OSES/DBSD Page 15
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26 MSGO036

Replace an SSA-1009/1042S (Tax Year2006)

Social Security Online
Www.socialsecurity.gov

nformation about Time Limits

oy ML
s

For security reasons, there are time limits for your work on each page

« Youwill recsive awarning after 25 minutes on a page that will allow you to extend your time.

+ Alfter the third waming on a page, you must move to another page or your time will run out and
wou will be logged out

+ [fyou have turned JavaScript off in yvour browser, you will not receive these wamings. After
spending 30 minutes on a page, you must move on to another page or you will be logged out

Do not use the Back button on your browser to move backward.
Do not use the Enter key to move around in the application.

Close this windowi to return to the application.

Prepared by OSES/DBSD Page 16
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2.7 MSGO037

Replace an SSA-1009/1042S (Tax Year2006)

Social Security Online
Www.socialsecurity.gov

ﬁw Unable to Process Your Request
R

If the information you gave us is correct, we're sorry but this service is not available to you

If the information you gave us is correct and you are currently receiving bensfits, online access to
your account may be blocked. For assistance, please call us at 1-800-772-1213, Monday through
Friday between 7 am and 7 pm I you are deaf or hard-of-hearing, call our toll-free TT¥ number, 1-
8003250778, Monday through Friday between 7 am. and 7 p.m

[ Feturn to Online Senvices ]

Prepared by OSES/DBSD Page 17
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2.8 MSG045

Replace an SSA-1009/1042S (Tax Year2006)

Social Security Online
Www.socialsecurity.gov

ﬁw This Service Will Shut Down Within 30 Minutes
L

The replacement 1099/10425 service is available during the following hours (Eastern Time):

tonday through Friday: 5:00 Ak - 1:00 A
Saturday 500 AM-11:00 PM

Sunday: 8:00 AM - 10:00 P

Holidays: 5:00 Ab - 11:00 PM

Select Continue to start your request now. If the system shuts down befare you finish it, you will have
0 begin again when the system becomes available.

Select Exit to go to the Social Security home page

Prepared by OSES/DBSD Page 18
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29 MSGO051

SocialSecurityOnlina Replaee an SSA-1099/1042S (raxvear 2006)

www.socialsecurity.gov

s Cookies Not Enabled

To get a replacement $5A-1099 or 10425 (for non-citizens/non-residents) onling, you must enable
"cookies" on your computer. We use "session cookies" that wie store on your computer only during
wour visit. The session cookie keeps you from losing information you've entered for a business
transaction with us if, during your visit, you leave our website and retum

Once you turn off your computer or stop using the Internet, the cookie is erased
To enable cookies, followr the instructions below for the browser you're using.
Microsoft Internet Explorer 6.0+

+ Select "Internet Options" from the Tools menu.

» Click onthe "Privacy" tab

« Click the "Default" button {or manually slide the bar down to "Medium") under "Settings".
+ Click "OK"

Microsoft Internet Explorer 5.x

Select "Internet Options” from the Tools menu

Click on the "Security" tab.

Click the "Custom Level" button

Scroll down to the "Cookies” section

Set "Allow cookies that are stored on your computer” to "Enable”
Set "Allow per-session cookies" to "Enable”

Click "OK"

Mozilla Firefox (1.0 final release and earlier)

« Gotothe "Tools" menu

» Select "Options"”

« Select the "Privacy” icon in the left panel

+ Check the box corresponding to "Allow sites to set cookies”
o Click "OK" to save changes

Netscape 7.1/Mozilla5.0

« Select "Preferences” from the Edit menu

» Click onthe arrow next to "Privacy & Security” in the scrolling window to expand
+ Under "Privacy & Security", select "Cookies "

+ Select "Enable all cookies”

o Click "OK"

Microsoft Internet Explorer 4.x

+ Select "Internet Options" from the View menu

Click onthe "Advanced" tab

Seroll down to find "Cookies" within the "Security” section.
Select "Always accept cookies”

Click "OK"

Netscape Communicator 4.x

+ Select "Preferences” from the Edit menu

« Find the "Cookies" section inthe "Advanced" category
+ Select "Accept all cookies" {or "Enable all cookies")
» Click "OK"
Exit Start Ower

Prepared by OSES/DBSD Page 19
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2.10 MSGO061

Social Security Online

Www.socialsecurity.gov

Replace an SSA-1009/1042S (Tax Year2006)

Is it safe to transmit
information to the Social
Security Administration over
the Internet?

What is encryption?

Why is special software
hecessary to access the
Internet application?

Why SSL?

| have the right software and |
am trying to connect during
your posted business hours,
but | still cannot access your
form. Why?

Internet Security Policy

SSA is taking all reasonable and proper measures, including encryption, to ensure that your
personal information is disclosed only to you. Howeyer, the Internet is an open system and there is
no absolute guarantee that others will not intercept the personal information you have entered or
requested and decrypt it. Atthough this possibility is remote, it does exist.

Encryption means that all information relating to you and your account is scrambled and locked with
amathematical key during the electronic transfer. Most browsers have an icon such as a keyora
lock to represent an encrypted made or session. A broken key, open lack, or no lock indicates that
the session or mode is not encrypted

So that your online request can remain confidential, S5 A uses a security protocol {method) called
Secure Sockets Layer (SSL) for this application. You must use a Web browser that supports SSL
Metscape Mavigator and Microsoft Internet Explorsr are two browsers that support SSL. Using this
security protocol, all information sent between your computer and our server is encrypted before
being sent over the Internet

SSL provides a high lewel of security and is the security protocol supported by more browsers than
any other It is estimated that about 92% of Web browsers have an SSL browser available for their
use

We have found that a number of business, government, and educational networks do not have their
firewalls configured to allow passage of secure Web traffic. Check with your systems administrator
to determine if this is the case atyour sits. fthis is the case, you will not be able to access this
application web site

Close this window to retum to the application

Prepared by OSES/DBSD
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2.11 MSGO062

Replace an SSA-1009/1042S (Tax Year2006)

Social Security Online
Www.socialsecurity.gov

- How to Request Your Replacement SSA-1099/1042S

We're sorry you cannot request a replacement SSA-1099/10425 online. You must call or visit us to
request a replacemsnt SSA-1089/10425
To contact Social Security: « Inthe United States
o call us at 1-800-772-1213 hMonday through Fridey between 7 a.m. and 7 p.m.
o call our tall-free TTY number, 1-800-325-0778, if you are deaf or hard of hearing,
Monday through Friday between 7 am. and 7 p.m., or
o visit your local Social Security Office

« Ifyoulive outside the United States, see Service Around the World

Prepared by OSES/DBSD Page 21
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2.12 MSG063

Social SocurityOnline Replace an SSA-1009/1042S (Tax Year2006)

Www.socialsecurity.gov

The Information You Entered Does Not Match Our Records

Please check this information: o If you typed the wrang information, you will need to correct it before continuing.
If the information is correct, contact Social Security. Be sure to tell the representative that you
tried to complete your request online and received this message.

To contact Social Security: « Call our tol-free number, 1-800-772-1213. Explain that you are unable to complete your
request online If you are deaf or hard of hearing, call our toll-free TTY number, 1-800-325-
0778. Representatives are available Monday through Friday from 7 am. to 7 pm

Go to your local Social Security Office and tell the representative that you were unable to
complete your request

If you live outside the United States, see Service Around the World

Previous

Prepared by OSES/DBSD Page 22
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2.13 MSGO064

Social SocurityOnline Replace an SSA-1009/1042S (Tax Year2006)

Www.socialsecurity.gov

ﬁw You Have Reached the Limit on the Number of Requests
Sl
We have not been able to match the information you entered with our records
To resolve the discrepancy: « Call our tol-free number, 1-800-772-1213. If you are deaf or hard of hearing, call our tolk-free
TTY¥ number, 1-800-325-0778. Representatives are available Monday through Friday from 7

am.to7pm

« Call orvisit your local Social Security Office
o [fyoulive outsids the United States, see Service Around the World

Prepared by OSES/DBSD Page 23
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2.14 MSGO065

Social SocurityOnline Replace an SSA-1009/1042S (Tax Year2006)

Www.socialsecurity.gov

/== How to Report a Change of Address and Request a Replacement SSA-
il - 1099/10428

You told us you hawve mowed and have not reparted this to us. To report your new address and
request a replacement S5A-1099/10425 at the same time, please call or visit Social Security
To contact Social Security: o Inthe United States
o call us at 1-800-772-1213 Monday through Friday between 7 am. and 7 p.m
o call our tollfree TTY number, 1-800-325-0778, if you are deaf or hard of hearing,
Monday through Friday between 7 am. and 7 p.m., or
o wisityour local Social Security Office

« Ifyou live outside the United States, see Service Around the World

Cloze this windowi to return to the application.

Prepared by OSES/DBSD Page 24
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2.15 M SGO066

Social SocurityOnline Replace an SSA-1009/1042S (Tax Year2006)

Www.socialsecurity.gov

/== How to Report a Change of Address and Request a Replacement SSA-
il - 1099/10428

You told us you hawve mowed and have not reparted this to us. To report your new address and
request a replacement S5A-1099/10425 at the same time, please call or visit Social Security
To contact Social Security: o Inthe United States
o call us at 1-800-772-1213 Monday through Friday between 7 am. and 7 p.m
o call our tollfree TTY number, 1-800-325-0778, if you are deaf or hard of hearing,
Monday through Friday between 7 am. and 7 p.m., or
o wisityour local Social Security Office

« Ifyou live outside the United States, see Service Around the World

Prepared by OSES/DBSD Page 25



Title: iRRet Screensfor OMB Clearance Package

Prepared by OSES/DBSD Page 26



The following revised Privacy Act Statement will be inserted into the form
at its next scheduled reprinting:

Privacy Act Statement
Collection and Use of Personal | nformation

Sections 223 and 1633 of the Social Security Act, as amended, authorize us to collect this
information. The information you provide will be used in making a decision on this
clam.

The information you furnish on thisform is voluntary. However, providing the
information on thisform is an obligation under the terms of your contract, and failure to
provide the information may result in a delay in processing the claim.

We rarely use the information you supply for any purpose other than for determining
eligibility. However, we may useit for the administration and integrity of Social Security
programs. We may also disclose information to another person or to another agency in
accordance with approved routine uses, which include but are not limited to the
following:

1. Toenableathird party or an agency to assist Social Security in establishing
rights to Social Security benefits and/or coverage;

2. To comply with Federal laws requiring the release of information from Social
Security records (e.g., to the Government Accountability Office and
Department of Veterans' Affairs);

3. To make determinations for eligibility in similar health and income
maintenance programs at the Federal, state and local level; and

4. Tofacilitate statistical research, audit or investigative activities necessary to
assure the integrity of Social Security programs.

We may also use the information you provide in computer matching programs. Matching
programs compare our records with records kept by other Federal, State, or local
government agencies. Information from these matching programs can be used to establish
or verify aperson’s eligibility for Federally funded or administered benefit programs and
for repayment of payments or delinquent debts under these programs.

Additional information regarding this form, routine uses of information, and our
programs and systems, is available on-line at www.social security.gov or at your local
Social Security office.



http://www.socialsecurity.gov/

Thefollowing revised PRA Statement will be inserted into the form at its
next scheduled reprinting:

Paperwork Reduction Act Statement - This information collection meets the
requirements of 44 U.S.C. § 3507, as amended by section 2 of the Paperwork Reduction
Act of 1995. Y ou do not need to answer these questions unless we display avalid Office
of Management and Budget control number. We estimate that it will take about xxx
minutes to read the instructions, gather the facts, and answer the questions. SEND OR
BRING THE COMPLETED FORM TO YOUR LOCAL SOCIAL SECURITY
OFFICE. Theofficeislisted under U. S. Government agenciesin your telephone
directory or you may call Social Security at 1-800-772-1213 (TTY 1-800-325-0778).
You may send comments on our time estimate above to: SSA, 6401 Security Blvd,
Baltimore, MD 21235-6401. Send only commentsrelating to our time estimate to this
address, not the completed form.




i1099 Application Screenshots with updated OMB Expiration Date:

Public Agreement Page (e€003.isp)

Form Approved OMB No 9960-0583
Expites -

Social Secusily provides this website for your conwvenience.

The Privacy Act Statenserit Social Security is aliowed to coliect the facts on this form under Section 205 of the Social Security
Act We need these facts to quickly identify who you are and provide the information you
requested Giving us these facts is volntary However, without them we may not be able to give
you the iformation that youwani. The Social Secunity Adrinstralion will nol use the information for
any other purpose If you wand to read more information on this subject, read i

Papernork Reduction Act This information coliection meets the requiremnents of 44 U $.C. § 3507, as amended by section 2
of the Paperwork Reduction Adl of 1995. You do not need to answer these questions unless we
desplay a vakd Office of Managemert and Budgel control number. The OMB control number for this
form is 09600583, expiration dale 12/31/2012 We estimate that it will take about 10 minutes to
Tead the instructions, gather the facts, and answer the questions. You may send comments on our
time estimate above t0: SSA, 1338 Anrvex Building, Batimore, MD 212350001 Sand only
comments on our tims astimate to this address, not the completed form.

By using this website, you agree to its imitahions

Drsaf E&Z’J

o P




General Information Page (ee004.isp)

Form Appreved. OMB No. 09600583
Expres}™ .77

[
nddrons that has not been LYes
reported to Social Security? “No

Why do you needi s . &
replacament 3SA-1099/104287 =
Have you had a change of

[CFmees ]




Login Page (ec005.isp)

Form Approved MR Mo 0860-0583
Expires oo

i@’ Please Log In

5 E

Bl

Please provide the followng information 1o identify yoursell. Be suie to fype your name asitis
shown on your Social Security Card.

* Denotes raqulred fiedd

*Your Social Security Number:
Use your own number even if you
are receiving benefils as a spousse,
parent or child under anather
person's aumber,

without dashes or spaces}

*Your Name: : Ci C "
Fiest, Mictdie Initial §if any), Last. s
Suffix {if any)

Other Last Name (if any):

For example, your name as shown
on a recent letter from Social
Security of your maiden name.

*Your Dats of Birth:
Month, Day, Year

e
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